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Patterns in High Cloud Coverage 
Adapted from:   My NASA Data Lesson Plans 

http://mynasadata.larc.nasa.gov/preview_lesson_nostds.php?&passid=87 

 

Focus on Inquiry 
The students will focus on inquiry by collecting and analyzing cloud coverage data on a specific location, by 
creating graphs to display the data, and by explaining and discussing their observations and looking for 
patterns in the data. 

Lesson Overview 
The students will collect the latitude and longitude data for their school location, plot this data on the Internet 
and collect real NASA cloud coverage data for this location.   Then they will import this data into Excel and 
create a chart to display the cloud cover percentage over a ten-year timeframe.  They will finally analyze the 
data for high cloud coverage and determine whether or not a pattern exists. 
 

Duration 
1-2 50-minute class periods 

Setting 
Classroom/computer lab 

Grouping 
Small groups of 2 or 3 

PTI Inquiry Subskills 
1.3, 2.1, 3.1, 3.7, 3.8, 4.2, 4.3, 
5.3, 7.2, 7.3 

 

Lesson Components 
Estimated 

Time 

Inquiry 
Subskills 

Used 

Technology 
Used 

Level of 
Student 

Engagement 
Brief Description 

Engage 
10 

minutes 
 

Computer / 
Internet 

2 

Students view pictures and 
videos of cloud formation and 
interact in a class discussion 
about cloud formation. 

Explore 
40 

minutes 
3.1, 3.7, 
3.8, 4.2 

Computer / 
Internet 

3 

Students collect GPS data on 
their school location and then 
use the Internet to collect cloud 
coverage data on that location 
and create a graph in Excel. 

Explain 
15 

minutes 

4.2, 4.3, 
5.3, 7.2, 

7.3 
 2 

Students analyze the cloud 
coverage data on their location 
and answer questions 
regarding their observations.  
Students discuss observations 
as a class. 

Expand 
50 

minutes 

1.3, 2.1, 
3.1, 3.7, 
3.8, 4.2 

 3 

Complete the experiment using 
three locations and find out 
which locations are affected by 
high or low cloud coverage. 

Evaluate     
The Excel charts and answers 
to questions can be used for 
assessment. 

Level of Student Engagement 
1 Low Listen to lecture, observe the teacher, individual reading, teacher demonstration, teacher-centered instruction 

2 Moderate Raise questions, lecture with discussion, record data, make predictions, technology interaction with assistance 

3 High 
Hands-on activity or inquiry; critique others, draw conclusions, make connections, problem-solve, student-
centered 

 

National Science Education Standards – Inquiry 

Design and conduct a scientific investigation 
Use appropriate tools and techniques to gather, analyze and interpret data 
Develop descriptions, explanations, predictions, and models using evidence 
Think critically and logically to make the relationships between evidence and explanations 
Communicate scientific procedures and explanations 

National Science Education Standards – Earth Science 

Clouds formed by the condensations of water vapor, affect weather and climate. 
Global patterns of atmospheric movement influence local weather.   

Louisiana Grade Level Expectations – Inquiry 
Gr. 8, Inquiry GLE#4. Design, predict outcomes, and conduct experiments to answer guiding questions (SI-M-A2) 
Gr. 8, Inquiry GLE#6. Select and use appropriate equipment, technology, tools, and metric system units of measurement 

to make observations (SI-M-A3) 
Gr. 8, Inquiry GLE#7. Record observations using methods that complement investigations (e.g. journals, tables, charts) 
(SI-M-A3) 

http://mynasadata.larc.nasa.gov/preview_lesson_nostds.php?&passid=87
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Gr. 8, Inquiry GLE#9. Use computers and/or calculators to analyze and interpret quantitative data (SI-M-A3) 
Gr. 8, Inquiry GLE#11. Construct, use, and interpret appropriate graphical representations to collect, record, and report 

data (e.g., tables, charts, circle graphs, bar and line graphs, diagrams, scatter plots, symbols) (SI-M-A4) 
Gr. 8, Inquiry GLE#13. Identify patterns in data to explain natural events (SI-M-A4) 
Gr. 8, Inquiry GLE#16. Use evidence to make inferences and predict trends (SI-M-A5) 
Gr. 8, Inquiry GLE#19. Communicate ideas in a variety of ways (e.g. symbols, illustrations, graphs, charts, 

spreadsheets, concept maps, oral and written reports, equations) 
Gr. 8, Inquiry GLE#22. Use evidence and observations to explain and communicate the results of investigations (SI-M-

A7) 

Louisiana Grade Level Expectations Earth Science  
Gr. 8, GLE#24 – Investigate and explain how given factors affect the rate of water movement in the water cycle (e.g., 

climate, type of rock, ground cover) (ESS-M-A10) 

 
Materials List (per group) 

 Computer with Internet access  
 Microsoft Excel software  

 
Advance Preparation 

1. Gather materials necessary to complete lab. 
2. Before implementing the lesson with students, it is strongly recommended that you check to see 

that the browser being used is compatible with the NASA Live Access Server, and that the pop-up 
blockers are turned off. 

3. Also, it may help if you run through the student procedure to get acclimated with the website and 
with importing your data results into Excel. The Excel directions listed may vary based on the 
version of Excel that is on the computer.  So by running through the activity, you familiarize yourself 
with the procedure in order to better answer student’s questions. 

 

Other Information 
Learning Objectives 

 Students will locate real NASA satellite data resources on the Internet.  
 Students will be able to create and use a graph to read and analyze data.  
 Students will be able to conclude information based on the graphs they produce. 

 
Prior Knowledge Needed by the Students 

 Accessing websites on the Internet  

 Using GPS or resources to find location  

 Basic spreadsheet knowledge 

 Graphing skills 

 
Procedure 
 
Engage   

1. Show students pictures of clouds (using internet). 
Here are some good websites with cloud pictures:  
http://ww2010.atmos.uiuc.edu/(Gh)/guides/mtr/cld/cldtyp/home.rxml 
http://www.acclaimimages.com/search_terms/cloud_formation.html 
http://www.weatherquestions.com/Cloud_formation_convective.gif 
And if time, here are a few short web videos from YouTube of cloud formation: 
http://www.youtube.com/watch?v=_EvpJ5ILX84 
http://www.youtube.com/watch?v=vUcB8trxIkk 

2. Engage the class in a discussion on cloud formation:  Clouds are collections of water vapor in the 
atmosphere. Moisture collects in the atmosphere due to the evaporation of water, thus evaporation 
plays an essential role in the water cycle. The oceans are huge sources of water for evaporation.  
Clouds form when moisture rises, cools, and changes to water or ice. Ask the class:  But what makes 
the moisture rise into the sky? It can happen three ways:   

a. Sunshine: the heat of the sun can cause the air to rise, taking water vapor with it high into 
the sky. 

b.  A Front: a cold front will bring cold air under warm air, forcing it to rise, and a warm front 
will force warm moist air up over the cold air. 

c. Mountains: When winds blow against mountains, the moist air is forced upward. 

http://ww2010.atmos.uiuc.edu/(Gh)/guides/mtr/cld/cldtyp/home.rxml
http://www.acclaimimages.com/search_terms/cloud_formation.html
http://www.weatherquestions.com/Cloud_formation_convective.gif
http://www.youtube.com/watch?v=_EvpJ5ILX84
http://www.youtube.com/watch?v=vUcB8trxIkk
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Cloud cover fraction (percentage) represents the fractional area covered by clouds as observed 
from above by satellites. It is estimated by counting the number of satellite fields-of-view (called 
pixels, about 5 km across for ISCCP) that are determined to be cloudy and dividing by the total 
number of pixels in a region about 280 km across. 

 
Explore  

1. To access the location of your school site to use with the Live Access Server, go to the Maporama 
website:  http://world.maporama.com/Default.aspx.  Have computers defaulted to this website.  
Provide your students with the school address and have them enter it into the Maprorama website 
under “Maps”.  If the address cannot be found, have students enter only the city and state or possibly 
a point of interest (like LSU) in Baton Rouge and search on that criteria instead. 

2. Have students work through the student procedure in the Blackline Master 1.  You could have 

another window of each computer connected to the NASA Live Access Server 
(http://mynasadata.larc.nasa.gov/las15/servlets/dataset) and make sure that pop-up blockers are 
turned off.    

 

Explain 
1. Have students work through the questions on their Blackline Master 1.   

2. Review the answers as a class and generate a class discussion on the students’ observations. 

 
Expand  

1. As a class, pretend you are all on a team that wants to start an airline company. Have the students 
pick three airports for which you might want to offer flight service.  Then, ask the class:  Which type of 
cloud coverage do you think will matter most to airline company pilots? 

2. Use the NASA Live Access Server and the student procedures in the Blackline Master 1 to determine 
which airport location has the least high cloud coverage. Also look at which airport has the least low 
cloud coverage. 

 

Evaluate 
1. The charts that the students generate and the answers to the questions on the Blackline Master 1 can 

be used for assessment. 

 
Blackline Masters 

1. Patterns in High Cloud Coverage 

 
Supplementary Resources 
 
Credits 
My NASA Data Lesson Plans 
Lesson plan contributed by Shay Vanderlaan, Norwalk, California 

 
 
 

http://world.maporama.com/Default.aspx
http://mynasadata.larc.nasa.gov/las15/servlets/dataset
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Name:  ________________________________________________ Date:  ____________ 
 

Patterns in High Cloud Coverage 
 

Student Procedure: 
 

1. Your computer should be connected to the Maporama website:  
http://world.maporama.com/Default.aspx. Under Maps, enter your school address, city and zip code, 
then click the orange and white arrow to submit.  

2. Look for the box on the left side of the screen that is labeled Information. The address and GPS 
location should be displayed there. Write down the GPS location (latitude and longitude) here: 
 

Latitude: __________________________ Longitude:  __________________________ 
 

3. Now, navigate to the NASA Live Access Server:  
http://mynasadata.larc.nasa.gov/las/servlets/dataset. 

4. From the home page, select Atmosphere, then select Clouds, then select Cloud Coverage, and finally 
check the box next to Monthly High Cloud Coverage (ISCCP).  Click the red Next link. 

5. On the next page, select the following: 
Select view: Time series (t) 
Select output: ASCII file 
Select region: Full region 
Then, on the right of the map, enter your GPS location. 
Select time range: Jan 1994 thru Jun 2005. 
Click Next.   

6. Click on the “Your ASCII file” link that opened in a new pop-up window.  
7. Save this data as a text file by clicking File  Save As.  Enter “Your School Name + Cloud Coverage” 

(for example, “LSU Cloud Coverage”) as your file name and save it to your desktop or another 
specified location.  Close this pop-up window. 

8. Open Microsoft Excel. Click on the Data menu at the top, then under the Get External Data section, 
click on Import Text File or From Text.  Choose your file and click Import to retrieve data.  Note:  
These directions may vary based on the version of Excel you have. 

9. The Import Wizard opens. Choose delimited. For Start Import at row, enter 9.  Choose Tab and 
Space as Delimiters.  Click to Finish and import data.  Note:  Again, these directions may vary based 
on the version of Excel you have. 

10. If column B is full of 0’s, highlight column B, right click, and select Delete to remove this column.  All 
you need is the two columns that contain the date and the cloud coverage.   

11. To create a chart displaying this data, first highlight columns A and B, then click on the Insert menu at 
the top.  Under the Chart section, select the 2-D Line graph. Note:  Again, these directions may vary 
based on the version of Excel you have. 

12. Your chart should appear.  You can format it by resizing it to make it bigger.  Delete the legend on the 
right of the graph if preferable.  You can also use the Layout menu at the top to enter a Chart Title 
and to label the X and Y axes as “Month/Year” and “Cloud Percentage”.  Note:  Again, these 
directions may vary based on the version of Excel you have.  Here is an example of a completed 
Cloud Chart: 
 

Blackline Master #1, pg. 1 

http://world.maporama.com/Default.aspx
http://mynasadata.larc.nasa.gov/las/servlets/dataset
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13. If possible, print out your data chart or save by clicking File  Save As.  Enter “Your School Name + 
Cloud Chart” (for example, “LSU Cloud Chart”) as your file name and save it to your desktop or 
another specified location. 

14. Answer the two questions below. 

 
Questions: 

 
1. Describe how the graph of cloud cover changes throughout the year. When is the coverage of clouds the            

greatest? Where is the coverage of clouds the least?  

_____________________________________________________________________________________ 

 

_____________________________________________________________________________________ 

 

_____________________________________________________________________________________ 

 

_____________________________________________________________________________________ 

 

_____________________________________________________________________________________ 

 

2. Looking at the multiple years of data, is there a stable seasonal pattern?  

_____________________________________________________________________________________ 

 

_____________________________________________________________________________________ 

 

_____________________________________________________________________________________ 

 

_____________________________________________________________________________________ 

 

_____________________________________________________________________________________ 

Blackline Master #1, pg. 2 


